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How to Run a Lender Search Report - Servicers

1. Access the Lenders Reporting System (LaRS) by clicking on the following ur!
link:

http://www.fp.ed.gov/fms.html
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4 F'\Inanclal FSA's Financial Management System (FMS) is a centralized system for all
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Financial Partners functionality to support financial planning and budgeting activities, Click here to access
Data Mart "
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Guaranty agenices use the Guaranty Agency Financial Report to request
payment from and make payments to the Department of Education (ED)
under the Federal Family Education Loan (FFEL) Pragram. Priar to
entering GAFR data electronically users are required to
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Lender Reporting System (LaRS) . TOP

Lender Reporting System (L aRS)

Lenders are required to submit quarterly student loan portfolio data to
receive payments and to report origination/lender fees due to the
Department of Education (ED). These payments are based on the
transmission of valid financial data via the Lender Reporting System
(LARS). The LARS integrates access to lender data through one system
and creates ad hoc query analysis functionality. Prior to entering LaRS data
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2. Click on the 'LaRS (formerly ED Form 799)' link on the right-hand side of
the web page to access the LaRS application.


http://www.fp.ed.gov/fms.html
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FINANCIAL MANAGEMENT SYSTEM

+Terms of Use This is a Government system, to be used by authorized personnel only. If you use this

computer system, you should understand that all activities may be monitored and recorded
by automated processes and/or by Government personnel. Anyone using this system
expressly consents to such monitoring. Warning: If such monitoring reveals possible
evidence of criminal activity, monitoring records may be provided to law enforcement
officials. This system contains personal information protected by the Privacy Act of 1974
(as amended). If you use this computer system, you are explicitly consenting to be bound
by the Acts requirements and acknowledge the possible criminal and civil penalties for
violation of the Act.

» Agree I Disagree

Copyright 2005. Federal Student Aid - Financial Management System.

Privacy Statement

3. After clicking on the LaRs link the following message regarding the
Terms of Use appear. Please read and click on the 'T Agree’ button.
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You are accessing a U.S. government information system, which includes this computer session, this computer network, all computers
connected to this network session. This information system is provided for U.5. government-authorized use only. Unauthorized or
improper use of this system may result in disciplinary action, as well as civil and criminal penalties. Personnel using remote access shall
not download or store government information on private equlpment optical or digital media. By using this information system, you
understand and consent to the following: You have no reasonable expectation of privacy regarding any communications or data
transiting this information system. At any time, the government may monitor, intercept, search and seize any communication or data
transiting this information system. Any communications or data transiting this information system may be disclosed or used for any
purpose.

By logging on, I agree and consent to these terms and conditions.

Login
Username

Password
Token

| Login
Register Token

LostForgot Token

Copyright (c) 2006, Oracle. All rights reserved.

Privacy Statement _

4. Affer clicking 'T Agree’, the login screen will appear.
a. Enter the username assigned to you by FSA FMS Operations in the
User Name field.
b. Enter your password in the Password field.
c. Enter the number generated by your Token.
d. Click on the Login button.
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a Oracle Applications Home Page - Microsoft Internet Explorer ;lglzl
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ORACLE E-Business Suite

Home Logout Preferences Help

Logged In As LARS LENDER

| Cracle Discoverer )

Navigator
[ FSA LARS Lender/Servicer Flease select & responsibility. |
Worklist

| Full List )

From Subject Sent
There are no notifications in this view.

@ TIP Yacation Rules - Redirect or auto-respond to notifications.
@ TIP Worklist Access - Specify which users can view and act upon your notifications.

Home | Logout | Preferences | Help

Copyright 2000-2005 Oracle Corporation. Al rights reserved. Privacy Staternent
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5. Once your login has been verified, double-click on 'FSA LARS Lender/Servicer’
to select a responsibility.
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73 Oracle Applications Home Page - Microsoft Internet Explorer
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[WJFSA LARS Lender/Service FSA LARS Lender/Servicer

FSA LaRS Form
FSA LaRS Profile

Others

Prafile

Concurrent
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Others : Requests

Run <
Set
Worklist
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From Subject Sent

There are no notifications in this view.
@ TIP Yacation Rules - Redirect or auto-respond to notifications.
@ TIP Worklist Access - Specify which users can view and act upon your notifications.

Home | Logout | Preferences | Help
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6. Under the heading Others: Requests, double-click on ‘Run’.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 = |EI|5|
File Edit “iew Folder Tools Window Help
(HAYO & 2VSP R DBHAL LEDHE 2 )
Func Documents
FSA LaRS Form
LaRS Form for Lenders & Servicers
FSA LaRS Form Top Ten List
FSA LaRS Profile
# + Others
-
#Sl
#.# What type of request do you want to run?
=
-
This allows you to submit an individual request
 Request Set
This allows you to submit a pre-defined set of
requests.
( oK [ cancer |
Recard: 101 | | =05C= J

7. After double-clicking on 'Run’ the Submit a New Reguest window will

appear. Click on the "OK' button.
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— Run this Request... -
( Copy...
MNarne Click on List
| Q of Walues
Parameters | (L% Button
Language |
( Language Settings. .. I Debug Options
— At these limes...
Fun the Job |As Soon as Possible ( Schedule. .
— Upon Completion...
v Save all Output Files
Layout
Notify Options. ..
Print to |
Help (C} ( Submit | [ Cancel )

8. Affer clicking on OK, the Submit Reguest window will appear. Place your
cursor in the name field and click on the list of values button.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 i =] 4]
File Edit “iew Folder Tools Window Help
(Heo 688G P R DN ER LAOL G ? )

O Submit Request

~ Run this Request.

Copy...

Mame

Language

MName Application

~ At these Times...— | Lender Sear ReponforLenders FA LAR

Run the Job

FS

— Upon Completion...

Layout
Muotify
Print to
I A | »
Help (C)
Eind Cancel
Choices in list: 2 | i

M start | | J Desktop **

J e0Ha |J @LaRSUse...l LenderSe...l @Lendersa..l @Oraclenp...l & oracle Ap..“"{éuracle A.. |@E@oﬁxafé 11:43 AM

9. Affter clicking on the list of values button, the Reportswindow will appear
with the name 'Lender Search Report for Servicers’ highlighted. Click 'OK'.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05
File Edit “iew Folder Tools Window Help

=10l x|

(B B8P R NN ER LB R ?

O Submit Regues

~ Run this Req
Copy

Mame

Parameters
Language American English

Language Settings Debuy Options

M= [FETEMENES S e s e e e o s e S i R S S S 2
— At these Time

Runthi senicer ID 700054 700054
| LenderID 877411 87741
¢~ Upon Comple Year 2005

CQuarter 3

L 4] | 3

[Qancel) (Clear) (Help )

Help (C) Submit Cancel

Record: 11 | | Listofvalu.. | | z08C=

9. Next the Parameters window will appear.

A. In the Servicer ID field, enter your servicer id number.

B. In the Lender ID field, enter the lender id number.

C. Inthe Report Year, enter the year of the reported 799 that you
want fo view.

D. Inthe Report Quarter, enter the quarter (1,2,3 or 4) of the
reported 799 you want to view.

E. Click the OK button.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 i =] 4]
File Edit “iew Folder Tools Window Help

) 2.
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XYL YTATEIP-I VIak | )

O Submit Regues

~ Run this R t

Copy
e Lender Search Report for Servicers] r

Parameters |?|]|]|]54:37?41 1:2005:3

Language |American English

( Language Settings [ Debuy Options
— At these Times...
Run the Ioh |As Soon as Possible ( Schedule. ..

~ Upon Completi

W Sawe all Output Files

Layout |

Hlotity | Options...

Frint to |“°I"i“t

Help (C) ( Submit [ | Cancsl )

Record: 11 | | Listofvalu.. | | z08C= J

11. Click on the 'Submit' button to run the report.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 . i =] 4]
File Edit “iew Folder Tools Window Help
(P 2 BESEP DD R LBOLE 2 )
_+> Befresh Data ‘ [ Find Reguests ) ( Submit a Mew Request... )
Reguest 1D Parent
MName | Phase Status Parameters

|BEEE  [Lender Search Reportfo| [Rufining 0 [Hormal ] 700054, 677411, 2006,3 | -

1]

( Hold Reguest [ Wiew Details... )I ( Wiew Output )I

( Cancel Request ‘ [ Diagnostics ) ( Wiew Log.. )
FRM-40400: Transaction complete: 1 records applied and saved. ‘
Record: 11 | o | | z08C=

12. The Reguest window will appear. Click on the Refresh Data button until the
Phase column for this report indicates Completed and the Status column
indicates Normal. (Note: this report should take approximately one minute
to run).
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&Dracle Applications - Copy of Production to UPGRDS 10-19-05 o ]
File Edit “Wiew Folder Tools Window Help
(LY &2 88P RPN LA E 2 )

( Refresh Data | [

Find Requests ) (

Submit a Mew Request...

Reguest D Parent

| Mame Fhase Status

Parameters

‘?I]I]I]ﬁai, 877411, 2005, 3

| [EEEZ L e ner Search Report fol [Completed  [Normal

1]

( Hold Reguest Wiew Details... )I Wiew Output |
( Cancel Request [ Diagnostics ) Wiew Log... )
Record: 171 | | =05C=

13. Click 'View Output’ to view the report.
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File

Edit

r5470-12.ed.gov:8008,/0A_CGI/;FNDWRR.exe?temp_i

Wiew  Favorites  Tools

Help

=1952562844 - Microsoft Internet Explorer

d=Eack - = - at | Qhsearch [GelFavorites EfMedia &4 | EN- S =

Address I&j https:/fr5470-12.ed.gov: 8008/ 0A_CGI/FNDWRR. exertemp_id=195256 2544

RUN DATE: 11

f07/05

U.3.

DEPARTHENT OF EDUCATION

FEDERAL FAMILY EDTUCATION LOAWN PROGRALM
INTEREST PAYMENTS SUBIYITEM
LENDEER SELRCH REFPORT

LENDER: 577411 DUMMY LID FOR ED ACCTG FFELFP ADMIN USE CMNLY WASHINGTON DC zZozZoz
SUHMMARY FOR: 3/ 2005 SERVICER ID:700054 STATUZ:In FProgress FPROCESIING DATE: 11/07/2005
GROSS-INTEREST: $118.47 b
GRO35 SPECIAL ALLOWANCE: §19.50
LEZ3 ORIGINATICNH FEEZ: $300.00
LESS LENDEER FEES: §50.00
TOTAL DOCUMENT AMOUNMT: -$212.03
F/B INT LN ENDING AVERAGE i
QTR/YEAR CODE FEE RATE TT SAC BALANCE BALANCE ADJUSTHMENTS C.
PART I
o3/ 2005 FN .03 EVLER 3F $10,000.00 $0.00 $0.00
o3/ 2005 LN .005 EVAR 3F $10,000.00
PART I TOTAL
PART II
o3/ 2005 EC 047 3F $10,000.00 $10,000.00 $0.00 -
4] | 3
|&] pone E|° Internet 4

14. The report will be open in the web browser.
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470-12.ed.gov:6200/0A_HTML, FNDWRR.exe?temp B4 5F83EFBC6A4EDDINIZZE6AT4BF0558&]0g - Microsoft I = Ill
File Edit Wiew Favorites Tools  Help ﬁ
Mew 4 @Search [GilFavortes Media ¢4 | E- S =t D
Open... Chrl+O o
Edit 1820008 _HTML{bin/FUOWRR . exe?temp_id=1B45F83EFECAA4EDOS0922864A 74EF0558&l0gin=applsyspubjpub@DEYCOM j @Go | Links
VE =
< Save fs...
U.3. DEPARTHMENT OF EDUCATICN
Page Sstup... FEDERAL FAMILY EDUCATION LOAN PROGRAM
INTEREST PALYMENTS SUBSIYSITEM
Print Presiew. ., LENDER SEARCH REFCRT
Send 3
I e et P LID FOR ED ACCTG FFELP ADMIN USE OMLY WASHINGTCH DC 20202 Us
Properties
work Offline o004 SERVICER ID:700214 STATUS: Aocepted PROCESSING DATE: 06/07/2004
Close
GROSS-INTEREST: 651,33
GROS3 SPECIAL ALLOWANCE: §0.00
LE3S ORIGINATICON FEES: §0.00 e
LEZZS LENDER FEE3Z: §0.00
TOTAL DOCTMENT AMOUNT: $651.33
F/E INT LM ENDING AVERALGE AMOTNT
QTR/ TELR CODE FEE RATE TY SAC BALATCE BEALANCE ADJUSTHENTS CALCULATED
PART I
0z/ 20042 LD .005 EVAER 3F §1,326.00 $0.00 §0.00 §6.63
0z/ 2004 LN .005 EWVAR SF §1,326.00 §6.63
0z/ z2oog FD .03 EVALER 3F §1,326.00 §39.78
0z/ 2004 FN .03 EWVALER SF §1,326.00 §39.78
§0.00
PART I TOTAL
PART II
0z/ 2004 EC 05346 3F §15,809.00 $15,9z1.00 $0.00 $162.77
0z/ 2004 EC .04z 3F §17,424.00 $17,4z4.00 §154.55
0z/ 2004 EC 0486 3F $24, 545.00 $25,159.00 $304.01
|
4| | L4

Prints this page.

iastartl“ G- NN G |J Inb..‘l @Yah‘..l @Ora...l @TDU...' B Ho. . | prln...l ... | @untl...l ERe... | @Fln.‘.l EoRe... “@htt... \@5@&0 Fi43 AM

15. From the web browser, select File > Save As from the menu bar.
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16. In the Save Web Page window, select a folder to save the report in on your
hard drive. Name the report in the File Name field and then click on the
Save button. Be sure the save as type is ‘Text File'.

save Web Page 2]l
S avk i I@ by Documents ) j & =5 ER-

. T TS —
@ Mw,.-' Pictures

Higtary

T~
ILenders Search Report 877411 j ( Save I )
| Save as type: ITe:-:t File [*.txk) j Cancel |
Encading: I'W'estern European Pwindows] j

17.Right click on the Start button in the bottom left-hand corner of your
screen and select “explore”.

N Inbox, ..

[r)

@ 5 © || K
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_isix
File Edit “ew Favorites Tools Help ﬁ
smBack v = - | iQ search ||:E;FOIders 4 | 5o x w | Ed-

Acdress |23 My Documents x| @so

Folders

[H] Desktop

¥ @ My Diocurnents

E@, My Cornputer

é‘ 3% Floppy (a2
E1-= Local Disk {C:)
=[] BaCKUP

[:I Cognos Repotts
D Zognos6o

1 DELL

-1 DISCOVER
=1 Documents and S
{0 Administrator

-1 Al Users

{1 howard.bond:

{1 satnam.khals

{7 steve.Smith
1 svsTEM
EID

teresa.reynol

g
4

ettings

{1 Administrator DEPARTME-

B3-(] All Users. WINNT
{2 anthany.robinson
{7 constance herron
i | danald. adeyeye
{1 edward.corack
{7 everistus.okorkwo

5

| joakim, raumain

&}

{1 sMSCCMBootACtE:
{11 sMsClisveaccts
{1 smMsCiiToknLocalaccts:

lds

L Iy Documents

My Dﬁcuments

-_

of]

Lenders Search Report 877411
Text Document

Modified: 6/3/2004 2:39 M
Size; 6,56 KB

Attributes: {normal)

E=

[y Music

Motepad
Inkernet Explorer
Microsaft Excel For Windows

My Pickures

r nen

Print

Scan For Yiruses.,.

3 add ta Zip
3 Add ta Lenders Search Report 877411.zip

‘wordPad

Send To

Choose Program. ..

Cut
Copy

Create Shorkout
Delete
Rename

Properties

iastart”J m e L"%] e |J Inbo...l @How...l @Orac.‘.l %Tool...l %Navi.‘.l %Req... | %Find | %Rep... | @http‘..l @untit...”@lﬂy...

|<fjé®&¢) 2:44 PM

18. Open the folder where the report was saved, right-click on the file, select
Open With and then select Notepad.
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'] Lenders Search Report 877411 - Notepad

‘| File Edt Format Help

=10l x|

T ZhrlHm -
U.5. DEPARTMENT DOF EDUCATION =
OPE,. Crl+o FEDERAL FAMILY EDUCATION LOAN PROGRAM
S Chl+5 INTEREST PAYMENTS SUBSYSTEM
LENDER SEARCH REPORT
Save As...
Page Setup... LID FOR ED ACCTS FFELP ADMIN USE ONWLY WASHINGTON oC
Print... P 2004 SERWICER ID: STATUS:AcCcepted PROCESSING DATE: 06403/
Exit GROSS-INTEREST: $630, 35
GROSS SPECIAL ALLOWANCE: $0,00
LESS DRIGINATION FEES: $0. 00
LESS LENDER FEES: $0,00
TOTAL DOCUMENT AMOUNT: $630, 35
F/B INT LN ENDING AVERAGE o
QTR/YEAR  CODE  FEE  RATE T SAC BALANCE BALANCE ADJUSTMENTS
PART T
01/ 2004 LD L0085 EWAR SF $1,326.00 $0,00 $0.00
01/ 2004 LM L0005 EVAR, SF $1,226.00
01/ 2004 FO .03 EWAR SF $1,226.00
01/ 2004  FN .03 EWAR SF $1,326.00
PART I TOTAL
PART IT
01/ 2004 BC L0346 SF $1%,809.00 $1%,921.00 $0.00
01/ 2004 BC L0426 SF $17,424.00 $19,540.00
01/ 2004 BC L0456 SF $24,545.00 $25,159.00
01/ 2004  BC .08 SF $836.00 $835.00
PART II TOTAL
PART IIT
01/ 2004 BC EVAR SF SE $67,191.00 $70,481.00 =
1] | 2

19. Once the document is open in Notepad, select File > Print from the menu
bar.
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NOTE: This screen may look different on your computer due to
configuration differences.

2l

&% Print

General Lapout | F'apera’llualit_l,ll

— Origntatian

" Paortrait
% Landscape

— Page Order

% Front to Back
™ Back ta Frant

Pages Per Sheet: I 1 vI

Advanced... |
I
| Pritt I Cancel | Apply |

In the Print window, click on the Layout tab and change the Orientation

20.
from Portrait to Landscape. Click on the Print button to print to kick off

the print job.
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